ISSUE A
# Table of Contents

- **3 Introduction and Overview** .......................................................... 4
  - Introduction ................................................................................. 4
  - Cerner® Common Architecture .................................................. 4
  - PathNet® Millennium Resource Hierarchy .................................. 5
  - Biochemical Genetics instrument and bench ............................. 5
  - Information Security and Confidentiality ................................... 6

- **Terminology and Definitions** .................................................... 7
  - Introduction ................................................................................. 7
  - Mnemonics ................................................................................ 7
  - Accession Number .................................................................... 7
  - Naming Conversion ................................................................... 7
  - Orderable and Associated Assay ............................................... 8
  - Care set ..................................................................................... 8

- **PathNet® Millennium Reference** ............................................... 9
  - Client ....................................................................................... 9
  - Patient Type ............................................................................. 9

- **Cerner Application** .................................................................. 9
  - Getting Started ......................................................................... 9

- **General Laboratory Overview** .................................................. 12
  - Definitions ................................................................................ 12

- **Department of Order (DOE)** ................................................... 13
  - Overview ................................................................................... 13
  - Launching Department Order Entry (DOE) ................................ 13
  - Searching for Patient by DOE ................................................... 14
  - Placing Order ........................................................................... 15
  - Cancelling Orders ..................................................................... 19
  - Adding an order to an existing orderable (Accession Add-On) .... 21
  - Modifying Orders ..................................................................... 21

- **Patient Registration** .................................................................. 22
  - Creating a new encounter for a patient ..................................... 24

- **Modify the collection date/time of the specimen (Modify Collections)** ................................................................. 27

- **Logging in the specimen into BG Lab (Specimen Log-in)** ......... 28
  - Printing Specimen labels in Specimen Log-In ............................ 28
  - Specimen Log-in (By Accession) .............................................. 29
Label Reprint
To reprint labels by accession

Worklist Request
Creating a New Worklist
Adding Accessions to the Worklist
Deleting Accessions from the Worklist
Assigning a Worklist ID
Select a Worklist
Delete a Worklist
Print a Worklist from Worklist Request
Save a Worklist from Explorer Menu

Accession Result Entry (ARE)
Overview
Working in Accession Mode
Working in Worklist Mode
Working in Correction Mode
Working with Batch Result Entry (BRE)

Batch Result Verify (BRV)
Overview
Selecting a Worklist
Verifying Results

Pending Inquiry
Viewing Pending Procedures

Order Result Viewer (ORV)
Set the default setting for finding orders
Viewing Orders with Order List Mode
Viewing Results with Order List
Viewing comments in Order Result Viewer

Clinical Result Review (CRV)
Introduction and Overview

Introduction

The objective of this manual is to introduce the user to the PathNet® Millennium General Laboratory for daily running of the Biochemical Genetics laboratory. This manual only provides a summary of information in relation to how to carry out a specific task that needs for running an assay. Any additional information that is not needed for carrying out a task will not be included in this manual.

For full support of the users, please refer to Cerner® Solution Training Guide – PathNet® General Laboratory.

Cerner® Common Architecture

Cerner® computing systems are organised around a common architecture. The PathNet® System is an integrated computer system that links all divisions of Pathology into one system.

Each functional area within the system is defined as Solution. There are six main solutions with the PathNet® Millennium System.

<table>
<thead>
<tr>
<th>Solution</th>
<th>Laboratory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core</td>
<td>Looks after the overall functioning of the system, and includes functions</td>
</tr>
<tr>
<td></td>
<td>such as Database Administration, System Support, Specimen</td>
</tr>
<tr>
<td></td>
<td>Collection/Processing and Charting.</td>
</tr>
<tr>
<td>General Laboratory</td>
<td>Clinical Biochemistry, Haematology, Biochemical Genetics, Serology,</td>
</tr>
<tr>
<td>(GL)</td>
<td>Immunology, Endocrinology, Gastroenterology and Virology</td>
</tr>
<tr>
<td>Microbiology (MB)</td>
<td>Microbiology</td>
</tr>
<tr>
<td>Blood Bank (BB)</td>
<td>Blood Bank</td>
</tr>
<tr>
<td>Anatomical Pathology</td>
<td>Anatomical Pathology</td>
</tr>
<tr>
<td>(AP)</td>
<td></td>
</tr>
<tr>
<td>Helix</td>
<td>Molecular Pathology, Cytogenetics and Molecular Genetics</td>
</tr>
</tbody>
</table>

PathNet® General Laboratory solution is a major PathNet® Millennium section provides online ordering of procedures, specimen management, verification and result review for assays assigned to specific workbenches and automated instruments.
PathNet® Millennium Resource Hierarchy

The Cerner® PathNet Application is structured in a hierarchal format. A description and example of each level of the structure is summarised in the table below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Institution</td>
<td>The highest level of the hierarchy is the institution. Any other hospitals associated with RAHC using the same database, would be classed as other Institutions for this site. Royal Alexandra Hospital</td>
</tr>
<tr>
<td>Department</td>
<td>This is known as department. CHW Laboratory.</td>
</tr>
<tr>
<td>Section</td>
<td>This level refers to the actual divisions or major areas within the Institute. CHW Biochemical Genetics.</td>
</tr>
<tr>
<td>Sub Section</td>
<td>A Sub section refers to a functional area of the laboratory. This is previously called Workcentre in PathNet® Classic. Biochemical Genetics divides into 3 Sub Section.</td>
</tr>
<tr>
<td>Instrument/Bench</td>
<td>This refers to the actual work area. This is previously called Testsite in PathNet® Classic. Biochemical Genetics has 7 instruments and 7 benches.</td>
</tr>
</tbody>
</table>

Biochemical Genetics instrument and bench

<table>
<thead>
<tr>
<th>Sub Section</th>
<th>Instrument/Bench</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHW Biochemical Genetics Automated Subsection (Instrument)</td>
<td>CHW BG MS Enzymology</td>
</tr>
<tr>
<td>CHW BG Amino Acids Analyzers</td>
<td></td>
</tr>
<tr>
<td>CHW BG GCMS Organic Acids</td>
<td></td>
</tr>
<tr>
<td>CHW BG Konelab</td>
<td></td>
</tr>
<tr>
<td>CHW BG GCMS Other</td>
<td></td>
</tr>
<tr>
<td>CHW BG Capillary Electrophoresis</td>
<td></td>
</tr>
<tr>
<td>CHW BG MS Diagnostics</td>
<td></td>
</tr>
<tr>
<td>CHW BG XQ</td>
<td></td>
</tr>
<tr>
<td>CHW Biochemical Genetics Manual Subsection (Bench)</td>
<td>CHW BG Miscellaneous Manual Bench</td>
</tr>
<tr>
<td>CHW BG Cell Culture Manual Bench</td>
<td></td>
</tr>
<tr>
<td>CHW BG GAG Electrophoresis Manual Bench</td>
<td></td>
</tr>
<tr>
<td>CHW BG High Voltage Electrophoresis</td>
<td></td>
</tr>
<tr>
<td>CHW Biochemical Genetics Sendaway</td>
<td>CHW BG RCH Sendaway Bench</td>
</tr>
<tr>
<td>CHW BG AWCH Sendaway Bench</td>
<td></td>
</tr>
<tr>
<td>CHW BG Other Sendaway Bench</td>
<td></td>
</tr>
</tbody>
</table>
There is no longer has a workcentre for PathNet® Clinical Validation. Most of the results will go to the Review Queue. Senior Scientists and Head of Department are the only personnel to access the queue. In addition, there is a Read Queue for Head of Department to review the case which forwarded by senior scientist for further investigation.

**Information Security and Confidentially**

The username and password to access PathNet® Millennium is provided by IT department. Your system might require you to change your password on regular basis.

Suspend the Appbar while you are not around.
Terminology and Definitions

Introduction

This section defines the terminology used in the PathNet® computer system. Familiarity with the following terms is essential to understanding this User Resource Manual and using the PathNet® system.

Mnemonics

Mnemonics are the code used for a particular function or menu option in the system. Some examples of mnemonics of PathNet® Classic and PathNet® Millennium is summarised in the table below.

<table>
<thead>
<tr>
<th>PathNet® Classic</th>
<th>PathNet® Millennium Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COE</td>
<td>DOE</td>
<td>Department Of Entry / Patient Registration</td>
</tr>
<tr>
<td>WCP</td>
<td>Worklist Request</td>
<td></td>
</tr>
<tr>
<td>PRE</td>
<td>ARE</td>
<td>Accession Result Entry</td>
</tr>
<tr>
<td>TSB</td>
<td>BRE</td>
<td>Batch Result Entry</td>
</tr>
<tr>
<td>OID/OIP/RIA/PRX</td>
<td>ORV</td>
<td>Order Result Viewer</td>
</tr>
<tr>
<td>LRP</td>
<td>Label Reprint</td>
<td></td>
</tr>
</tbody>
</table>

Accession Number

The accession number format for Biochemical Genetics still use the prefix BG. For the rest of general laboratory is using Julian Date. The accession number is generated by the system automatically during DOE (i.e. when the request is booked in).

2

BG-YY-XXXXX

1. The first 2 letters indicate our department (BG).
2. The next two letters relate to the year
3. The last 5 digits accession number is generated by collection date and time and start at 1 at the beginning of each year

Naming Conversion

- Blood specimen (i.e. plasma or serum) – the name of orderable does not specify the specimen type. For example, 7-Dehydrocholesterol instead of Plasma 7-Dehydrocholesterol.
Non-blood specimen (e.g. urine) – specimen type as the last part of the orderable. For example, Creatine and Guanodinoacetate Urine instead of Urine Creatine and Guanodinoacetate.¹

**Orderable and Associated Assay**

An orderable in PathNet® Millennium is the term used for a test or test code. There are 2 names for an orderable – the Primary Name and Department Display Name.

- **Primary Name** – the long description of the orderable
- **Department Display Name** – it only display in DOE (i.e. it does not display in Powerchart for physician to place an order) and printed on specimen label

When lab users to search for an orderable, it can be done either by the long name or laboratory order name. Orderables may be reportable or non-reportable. For example, extraction volume is non-reportable.

The associated assay is the term used for procedure. An assay refers to a single reportable result. It can be ordered independently or as part of a group. For example, creatinine. It can be an assay of the orderable and it is also an orderable.

<table>
<thead>
<tr>
<th>Primary Name of an orderable</th>
<th>Department Display Name</th>
<th>Associated Assay</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-Dehydroxycholesterol</td>
<td>PL7DHC</td>
<td>7DHC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7DHCOM</td>
</tr>
<tr>
<td>Amino Acids and GAG Screen</td>
<td>UMP</td>
<td>AAP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OAP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DMB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DMBGAG</td>
</tr>
<tr>
<td>Creatinine Urine</td>
<td>CRT</td>
<td>CRT</td>
</tr>
</tbody>
</table>

**Care set**

It is previously called Supergroup in PathNet® Classic. It refers to a collection of individual orderable that are commonly ordered together.

<table>
<thead>
<tr>
<th>Care Set</th>
<th>Department Display Name</th>
<th>Orderable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urine Metabolic Screen</td>
<td>UMPX</td>
<td>UMP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CRT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXVL</td>
</tr>
</tbody>
</table>

¹ This does not apply to the Care Set

Drafting Officer: R. Lam
PathNet® Millennium Reference

Client

Client code no longer exists in PathNet® Millennium. The name of the client is needed to be entered while registering a patient.

NSW Newborn Screening Programme has been built as a client for all Newborn Screening follow-up and patients who diagnosed with metabolic disease.

Client Quality Assurance Programme is for registering external quality control specimens.

Patient Type

Patient code and location code no longer exists in PathNet® Millennium.

Cerner Application

Getting Started

Logging In

1. Double-click on PathNet® Millennium icon
2. Type your user name and password at the Cerner log-in window
3. Click OK or press the ENTER key

Logging Out

1. Click Exit from Task Menu
2. Exit Application window opens
3. Select “Exit and shut down the application”
4. Click Yes
Appbar Customization

1. Place the cursor over the Appbar icon
2. Right-click on the Appbar to reveal options.

**Suspend**: When you step away from the terminal for a period of time and do not want another user to open applications during your absence

**Change User**: If the previous user has left and you want to log in under your own Username select this option

**Large Buttons**: Selecting this option increases the size of the icons on the Appbar. To “undo” this option, right-click on the Appbar and re-select the Large Buttons option
3. Click Appbar icon to reveals more options. The following menu appears:

- Suspend
- Change User...
- Change Password...
- Applications...
- Customize...
- Auto Hide
  - Always On Top
  - Allow Floating
- Large Buttons
- Help...
- About Cerner AppBar...
- Exit

**Change Password**: Should not be used unless otherwise specified

**Customize**:  
- i) Click on the “Button” tab. This allows you to add/remove icons from your AppBar by clicking on the open box next to the application name  
- ii) Once you select the desired applications, you can arrange those applications in any order using the “Move” arrows  
- iii) Click “OK” to save changes

Please do not leave the computer while still signed on
General Laboratory Overview

Definitions

(Please add these to the Appbar)

**Department of Entry:** Patient Registration and Place an order

**Pending Inquiry:** Use Pending Inquiry to view the list of ordered procedures, for a specific test site or subsection, that have not been completed. You have the option to view only the ordered procedures that have been received or all ordered procedures for the selected test site.

**Worklist Request:** Worklist Request is used to prepare a worklist or worksheet using a predefined worklist name. An existing worklist can be printed, or an adhoc worklist can be created.

**Accession Result Entry:** Use Accession Result Entry to enter results for General Laboratory procedures ordered on a single accession number. You can select a specific ordered procedure and a test site to limit the information displayed for the selected accession number.

**Batch Result Entry:** The Batch Result Entry application is used to enter results for a specific orderable item for multiple accession numbers.

**Batch Result Verification:** Batch Result Entry is to verify multiple general lab results at the same time. You can select a saved worklist and verify all performed results that are associated with accession numbers on that worklist.

**Order Result Viewer:** Order Result Viewer is used to display the list of ordered items with access to results for a selected patient for a specified date/time range.

**Explorer Menu:** Explorer Menu is to where we print the worklist

**Specimen Login:** Use Specimen Log-In to document specimen collection information, such as the collection date and time

**Modify Collections:** Use Modify Collections to change the collection date and time

**Label Reprint:** Use Label Reprint to print extra labels
Department of Order (DOE)

Overview

An order can be entered into Department Order Entry or an order from PowerChart®.

Departmental Order Entry (DOE) enables you to place laboratory. You also may add on an order to a previous order, cancel an order, and register a patient prior to entering orders. This application is utilized by laboratory personnel. Powerchart enables non-ancillary departments (i.e. Nurses, Physicians, etc) to place orders for the laboratory departments.

Launching Department Order Entry (DOE)

1. Click the Cerner Appbar.exe icon on the desktop
2. Enter the User name and Password
3. Cerner Appbar is displayed along the top of the screen
4. Click the globe button to open DOE
Searching for Patient by DOE

1. You can search the patient by client or name by clicking patient registration button.
2. You can do it either enter MRN or Patient name or both.
3. Click Search or alternately press Ctrl + S.
4. The result will be displayed in the Encounter Search Window.

5. For all new patients, please refer to “Patient Registration”
Placing Order

1. You must first select the department from which you are placing orders from. From the menu, select View -> Orderable Filter -> Laboratory. Once selected, this setting remains for all subsequent signons to this application for your username.

2. Enter the order or the first few characters into Orderable box then press Enter.
3. A “Find Catalog Item” dialog box opens with a list of matching orderables

4. From the list, select the appropriate orderable and press OK

5. Several order details are displayed in yellow. Yellow indicates that a response is required before the order can be placed

- **Specimen Type**: It will automatically display depends on the orderable you have entered
- **Collected**: always mark as collected
- **Specimen Received Location**: Set CHW BG Login as default location
- **Print Label Y/N**: always marked as Yes
- **Accession number**: For system downtime only
• **Copies To:** a report copy can be done up to 10 different physicians

<table>
<thead>
<tr>
<th>Collection Date and Time</th>
<th>Collected By</th>
<th>Collection Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>T</em>**/****</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Label Printer</th>
<th>Aliquot Label Y/N</th>
<th>Aliquot Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ordering Physician (Name)</th>
<th>Order Date/Time</th>
<th>Order Communication Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>None, Specified</td>
<td>31/05/2013</td>
<td>Written</td>
</tr>
</tbody>
</table>

• **Collection Date and Time:** If collection date and time is not provided, enter “T” for today’s date, “N” in the Time filed for the current time.

• **Collected by:** Unless otherwise indicated, type into “Ward” for all CHW specimens and “OUTREF” for all external specimens.

• **Collection Priority:** Set “RT” as a default collection priority

• **Label Printer:** Select the appropriate label printer from a drop-down list. Once selected, this setting remains for all subsequent signons

• **Aliquot Label Y/N:** No aliquot setting for BG

• **Aliquot Printer:** No aliquot setting for BG

• **Ordering Physician (Name):** Enter the physician’s last name or to initiate a search, press the button. If physician’s name has not been provided, type “None, Specified”

• **Order Date/Time:** Default

• **Order Communication Type:** Set “Written” as a default communication type

6. You can add comment by clicking comment toolbar button and comment box is displayed

7. Press F5 for current date and time

8. Click Close to finish editing the comment

9. Click Add Orderable to Scratchpad. The orderable is added to the scratchpad at the bottom on the screen or press Ctrl + A.

10. To add more orders, type the order in the Orderable box. Press Enter. The order details are the same as the previous order. Press Ctrl + A.

11. When you are finished adding orderables to the scratch pad, click Submit Orders. Or press Ctrl + O.
12. An accession number will be generated automatically
13. The duplicate order is highlighted yellow in the scratchpad, the submission status is indicated as Duplicate Order Found. Click the View Submission Errors toolbar button to review the result
14. The Duplicate Orderables Box dialog box indicates duplicate order exists

Notes are not saved to the clinical report where Comments do become a permanent part of the chart
Cancelling Orders

You can cancel the order by either Department of Order or Pending Inquiry.

Cancelling order from Department of Order

1. Click **Cancel Orders** button
2. All orders eligible for cancellation are displayed in the centre of the window
3. Select the order that you want to cancel
4. Document the cancel reason and Canceling Physician
5. Submit cancel order

Cancelling order from Pending Inquiry

1. Click **Pending Inquiry** button
2. Highlight the order that you want to cancel. You can cancel multiple orders.
3. Click the Cancel order button
4. Select the Cancel Reason from the drop-down list

5. Click Cancel Orders

Cancel Reason and Cancelling Physician are mandatory field when cancelling the order in Department of Entry (DOE).
Adding an order to an existing orderable (Accession Add-On)

1. Click Accession Add On button.
2. Enter the accession number in the Accession Number box.
3. Start entering the accession no. by BG then press TAB.
4. Press Enter to retrieve the orders.
5. Click Add Orderable to Scratchpad or press Ctrl + A.
6. When you are finished adding orderables to the scratchpad, click Submit Orders or press Ctrl + O.

Modifying Orders

You can modify the following details for orders placed for patient:

- Ordering Physician
- Consulting Physician
- Chart Copy Location
- Reporting Priority

1. Click Modify Order button.
2. Select the Client and type the patient name.
3. All available orders will automatically populated. Click the Filter button to sort the labs and encounters.
4. Click the order that you want to modify and modify it.
5. After you have modified the order, click Add Order to scratchpad button.
6. Click Submit button.

To modify the collection date/time, you need to go to Modify Collections.
Patient Registration

1. Open Department of Entry (DOE) by clicking the globe button
2. Click Patient Registration button
3. Enter the name
4. Click Add Person button if no persons found
5. Organisation dialog box displays.
6. Enter the Client Name and Facility Name as "CHW"
7. Click OK
8. The PathNet Registration conversation displays.
9. Enter all required field (Fields highlight as yellow)

10. Enter MRN for the following clients:
   - Staff Health
   - Newborn Screening
   - Sydney Children’s
   - CHW

11. In the field “Medical Flag”, select one of the following from the drop-down menu:
   - Eligible. Aust. Resident if medicare number provided – enter 11-digit Medicare Number
   - Ineligible – for all overseas patients
   - Not Known/Not Stated if medicare number is not provided

12. Enter Patient Name

13. In address category, select QAS from drop-down menu, tab to address help. Click single line address button. Enter the address in the Enter Search box.
Enter the address in the following format <no.>, <street>, <suburb>, <state>.
The address will display
Click “Accept” button
For a new search, you need to click the New Search button on the Toolbar then click
the Single Line button.

14. For Visit Date and Visit Time, enter collection date and time
15. For CHW patients, Location is a required field.
   For DBSMSUD patients, select “Biochemical Genetics” from drop-down menu.
   For patients from non-CHW hospitals, enter their MRN into Client MRN field.
   For patients from private laboratory, enter “NA” into Client MRN field

16. Attending doctor: For new doctor, type “Not, Listed”. Enter the Provider Name, Provider Number and Doctor’s Address

17. For Overseas Doctor, type “Overseas doctor”
18. After entered all required field, click OK.

Creating a new encounter for a patient

1. Click Patient Registration button
2. Enter the name and click Search
3. Click Add Encounter button
4. Organisation dialog box displays.

5. Enter the Client Name and Facility Name as “CHW”.
6. Click OK
7. The PathNet Registration conversation displays.
8. Patient demographics will auto-populate.
9. Enter the rest of the required fields.
10. Click OK button
Modify the collection date/time of the specimen (Modify Collections)

You can modify the collection date and time for a container or order

1. Click Modify Collections button
2. Enter accession number for the orders whose collection information you want to modify
3. Select Modify option from Mode
4. Click Retrieve

5. Double-click the appropriate cell and enter the information
6. Select Modify from Task menu to save the changes
7. You will be prompted for confirmation. You also may be prompted to reprint labels and to specify a label printer.
8. For multiple orders on the same accession, left-click the “Coll Date” column and modify the date then left click the “Coll Time” column and modify the time
Logging in the specimen into BG Lab (Specimen Log-in)

Specimen Log-in is used to document specimen collection information, such as the collection time, collection ID, collection method and the location where the specimen was received. Each log-in location is stored by the system along with the date and time the specimen was logged in and the person who received it.

Printing Specimen labels in Specimen Log-In

1. In the Log-In dialog box, select Label Printer from the Task menu

2. In the Label Printer box, select the label printer to which you want the specimen labels to be sent. Uncheck the box for Default Aliquot Printer. Click OK and save your selection.
Specimen Log-in (By Accession)

1. Click Specimen Log-in button
2. Select Log-in by Accession

3. Click Retrieve
4. Enter the accession number or scan the barcode of the specimen that you want to log-in
5. Make sure CHW BG Login is selected from drop-down list. Click Log In.


**Label Reprint**

To reprint labels by accession

1. Click **Label Reprint** button
2. Select the Accession tab
3. Enter the first accession number in the Starting Accession box
4. Enter the end accession number in the Starting Accession box
5. Select the Label Printer
6. Click Print

![Label Reprint window](image)
Worklist Request

You can use Worklist Request to create or print your worksheet. You can rearrange the order in which accession numbers are displayed on the worklist and manually create a worklist by entering or scanning accession numbers in a specific order.

Creating a New Worklist

1. Click Worklist Request button
2. Click New Worklist button to open a new worklist
3. Select the test site from drop down menu
4. Select the worklist that you want to work on, click OK to create your worklist
5. Click OK

6. All In lab samples that you select for this orderable are displayed
Adding Accessions to the Worklist

1. Select Insert Row from the Edit menu or click the Insert Row button.
2. Enter the accessions or scan the sample barcode you want to add to the worklist.
3. Click Add.
4. The accession that you have entered is now displayed on the worklist.

Deleting Accessions from the Worklist

1. Click the accessions or scan the sample barcode you want to add to the worklist.
2. Select Delete Row from the Edit menu or click the Delete Row button.
3. The accession that you want to delete is disappeared on the worklist.

Assigning a Worklist ID

1. Click Assign Worklist ID button to assign ID.
2. Enter the name and the date that performing the assay.
3. Click OK. Worklist ID has been assigned to the worklist.
Select a Worklist

1. Select Worklist from the Task Menu or Click Select the worklist button
2. Select the worklist name from the Worklist Name list
3. Click OK
Delete a Worklist

1. Select Worklist from the Task Menu or Click Select the worklist button
2. Select the worklist name from the Worklist Name list
3. Selected worklist opens
4. Select Delete Worklist from Task menu or click Delete Worklist button
5. Click yes to delete the worklist

Print a Worklist from Worklist Request

1. Select Print from Task menu or click Print button
2. Select the printer and click OK
Execute a Worklist in Explorer Manual

For BG UMP, BG EXVL and BG OROTG worklists

1. Double-click Explorer Menu button on Appbar
2. Double-click the folder - Main Menu on the right hand side
3. Double-click Pathology Reports
4. Select the appropriate worklist and double-click
5. Click Execute

6. Report Output is generated
7. Copy the patients lists to the appropriate worklist template in G:// Drive
For BG Multitests worklists

1. Double-click Explorer Menu button on Appbar
2. Double-click the folder - Main Menu on the right hand side
3. Double-click Pathology Reports
4. Select BG Multitest Worklist
5. Checking the test that you want
6. Click Execute
Accession Result Entry (ARE)

Overview

In Accession Result Entry (ARE), you can enter and review results for a single accession number and review results sent from XQue. You also can select worklists and correct verified results.

Accession Result Entry has multiple result entry modes, including Accession, Instrument Queue, Worklist, and Correction. These modes enable you to use Accession Result Entry in different ways.

Working in Accession Mode

1. Click Accession Result Entry button
2. Enter BG then TAB to enter the year
3. Tab to enter the accession number
4. Click Retrieve (or press ALT+E)
5. You can convert a result type by right-click the Result Cell and select Convert Result
6. You can view previous results by select Previous Results from the Results menu. You can view up to the last 15 results.
7. You can view procedure information by right-clicking the Result Cell
8. You can also add comment by selecting Comments in the Result Cell
9. Double-click the Result cell to start entering the result.
10. To enter the batch comment, right-click in the column header above the checkboxes, select Select All. Select the checkboxes that you want to enter the comment or selecting Batch Comment in the Result cell.
11. Click Verify button after entering all the results and comments (press ALT+V)

**Working in Worklist Mode**

1. When you need to review or enter results from a worklist, use Worklist mode in Accession Result Entry.

2. Select Worklist Mode from Mode menu
3. Click the ellipsis button to search the worklist
4. Select the instrument from Test site drop-down menu
5. To enter results in Worklist mode, you select an existing worklist ID. The first accession number in the worklist is displayed automatically

6. The procedure for which results are to be entered is displayed along with information about the person for whom the procedure was ordered.
7. You can view procedure information by right-clicking the Result Cell
8. You can convert a result type by right-click the Result Cell and select Convert
9. You can view previous results by select Previous Results from the Results menu and view up to the last 15 results.
10. When all results have been entered, click Verify
11. The next accession on the worklist is displayed automatically
Working in Correction Mode

Once the result is verified, you must use the Correction mode of result entry in order to change the verified result.

1. Select Correction from Mode menu
2. Change the result value
3. Click Correct

Working with Batch Result Entry (BRE)

When you need to enter or verify results for multiple accession numbers for the same procedure, use Batch Result Entry. You can select the procedure and test site or select a specific worklist for which to enter results.

1. Click Batch Result Entry button
2. Enter the procedure and Test site

3. The procedure information is displayed in the Batch Result Entry window.

When entering results, you can select to move vertically or horizontally by selecting the appropriate option in the Task menu

Drafting Officer: R. Lam
4. Enter the result in the appropriate procedure and press Enter to move the result for the next procedure. A check mark will be entered automatically after each procedure is entered.

5. To view previous results, select Previous Results from Result menu.
6. To add batch comment, select Comments from Result menu.

7. When all results have been entered, click Verify.
**Batch Result Verify (BRV)**

**Overview**

Batch Result Verify (BRV) allows you to verify multiple results at the same time. In Worklist mode, you can select a saved worklist and verify all performed results that are associated with accession numbers on that worklist.

**Selecting a Worklist**

1. Click Batch Result Verify button
2. Select Worklist dialog box opens
3. Select Test site from the drop down list
4. Select the worklist you want to view
5. If you want to view only those orders that have pending procedures, select the Display Only Orders With Pending Assays option
6. Click OK

![Select Worklist](image-url)
Verifying Results

Performed results that are eligible to be verified in Batch Result Verify are displayed with a check box available for you to select.

Results that can be verified are displayed with a white cell background and can be selected. Procedures without a result also are displayed with a white cell background and can be selected. Results with a status of Verified, Corrected, or In Review are displayed with a gray cell background and cannot be selected. If you selected to display only pending results on a worklist, then no completed accession numbers are displayed.

1. Tick the checkbox for the results that you want to verify
2. Click Verify

The system does not validate that components of a calculation or interpretation result have not changed since you last refreshed or opened the worklist.
Pending Inquiry

Using Pending Inquiry to view the list of ordered procedures, for a specific test site, that has not been completed.

You can go directly from Pending Inquiry into Accession Result Entry if you want to enter results for a selected accession.

Viewing Pending Procedures

1. Click Pending Inquiry button
2. Select Pending dialog box opens

3. In the Test Site box, click the ellipsis button to list to view the all test sites
4. In the Procedure box, click the ellipsis button to see all procedures in this test site
5. To view the list of pending procedures that have been received into the laboratory, make sure the Received Only check box is checked.
6. Click OK to close Select Pending dialog box. The list of pending procedures will be displayed.
7. To view comments, select the line, and then select Comments from the View menu. The Comments dialog box opens.
8. To view the container information, select the line, then select Container Details from the View menu. The Container Inquiry dialog box opens.
9. To print the list of pending procedures, select Print from the Task menu.
10. To select a different test site and, optionally, a procedure, choose Select Procedures from the Task menu.

11. You can cancel order by clicking Cancel button from Pending Inquiry. (Please see “Cancelling order from Pending Inquiry” from “Cancelling Orders”)

12. You can also click Accession Result Entry Button from Pending Inquiry which will direct you to Accession Result Entry.

13. You can click Order Result Viewer button from Pending Inquiry which will direct you to Order Result Entry.
**Order Result Viewer (ORV)**

Use Order Result Viewer to display information pertaining to the ordered procedure and associated results.

Order Result Viewer has two modes, Order list and Flowsheet mode. Order list mode displays all orders in chronological order no matter if results exist or not. Flowsheet mode displays only those order that have clinical results for a certain time span. Those results are arranged on a grid containing cells sorted by categories and time.

**Set the default setting for finding orders**

1. The date range has been set as 30 days. Select the Default order box and change the data that you want.
2. Select Options from the View menu to open the Options dialog box
3. Specify the date range in the Date Range Group box
4. Select General Lab in Type of Activity and deselect the rest of the options.
5. Click OK to save the selected default settings and close the dialog box.

**Viewing Orders with Order List Mode**

1. Click the Order Result Viewer button
2. Order Result Viewer dialog box opens.
3. Select Order List from Mode menu
4. Select Find Orders from Task menu or click the blue arrow button to open the Find Orders dialog box.
5. Enter patient’s name in the Name box.
6. Enter accession number in the Accession Box.

**You can only search with accession number in Order List mode.**

7. In the Date Range group box, select the All Orders option to view all orders belonging to the specified person.
8. Click OK to retrieve the orders for the selected accession.
9. To branch to Accession Result Entry with a particular order, select the order, then select Go To Accession Result Entry from the View menu or choose the Accession Result Entry shortcut on your toolbar menu
10. To branch to Specimen Login with a particular order, select the order, and then select Go To Specimen Login from the View menu or choose the Specimen Login shortcut on your toolbar menu.
### Find Orders

- **Person**
  - Name: Test, Bg
  - Accession: BG-1300828
  - Group ID
  - Request ID

- **Date Range**
  - All Orders
  - Orders Between: 22/07/2013 and 23/07/2013

- **Type of Activity**
  - Anatomic Pathology
  - Blood Bank
  - Case Integration
  - General Lab
  - Hepa
  - HLA
  - Microbiology
  - Protocol

### PathNet General Lab: Order Result Viewer [Order List]

- **Demographics**
  - Name: TEST, Bg
  - Medicare: 123 234 2340
  - Client: Royal Alex Hospital
  - Age: 11 months
  - Sex: Female
  - Address: Discharged: 22/07/2013 23:59

- **Orders**
  - Accession: BG-1300828
  - Order: AP0C2
  - Specimen: Blood
  - Status: Completed

- **Ready**
  - Build: RO5AL
  - Date: 23/07/2013 15:33

---

**Drafting Officer:** R. Lam
Viewing Results with Order List

1. Double click the result and the General Lab Results dialog box opens.

2. For numeric results type, all results are displayed on General Lab Results dialog box. For textual result type, double click the procedure that you want to look into it. Text result dialog box opens.

Viewing comments in Order Result Viewer

1. Double click the yellow note button on the Toolbar.
2. When Physician is placing the order via PowerChart and the order has a comment, it will display as Order Note. Order Notes will not be printed on a chart.

3. To modify the Order Note, click Edit. Edit Comment dialog box opens.

4. Click OK when finish editing.
Clinical Result Review (CRV)

When hospital scientist verifies or corrects the result in result entry applications, results that qualify for review are routed to a review hierarchy, which includes a Biochemical Genetics Verification queue and a read queue. For the Review Queue, the results are to be reviewed and approved by either senior scientist or Head of Department. For the Read Queue, this queue can only be accessed by Head of Department. Senior Scientists will forward any Newborn Screening follow-up results or unusual results to the Read Queue for Head of Department to read.

1. Double-click Review Queue button
2. Select the orderable from the drop-down menu of Filter name

3. Double-click the orderable that you would like to review the DTAs
4. Result Viewer dialog box opens
5. Select the tests and click “Approve”
6. Click ✖️ to return the tests for scientist to re
7. Result has been reviewed
Faxing Results with Manual Expedite in Order Result Viewer (ORV) – Accession Level

1. Open Order Result Viewer
2. Click the Manual Expedite button from the task bar or select it from task menu
4. Select Printers from Print to Options
5. Select Report template – “LAB – Biochemical Genetics” from drop-down menu
6. Right click the Output device field
7. Select Filter Type then Fax
8. Click Submit
9. Select “Adhoc” from dropdown menu
10. Enter the fax number click Ok

11. Click Submit
Scanning Request Documents

To scan a request document image

1. Click on the Order/Result Viewer icon (ORV) to open ORV
2. If you use patient's name used- eg. Test, Mock and click on icon to right of name with three dots on it
3. Select the relevant patient with mouse
4. Click on Order List
5. Scroll down and click on the row of the accession number you have scanned an image to.
6. Click the Images icon on the toolbar
7. Click New button
8. Click on the drop down menu for the *Select an image type: field and select “Request Documents” as result type.
9. Place a document in the scanning tray and click on the Scan button
10. Click on the Scan button once more
11. Click on the Close button
12. Click on the OK button

To view a request document image

1. To view the image in this Document Image window click directly onto the desired document name
2. If the error appears 'Timeout has occurred. Refresh to continue.' then click on the Expand all icon and then the Collapse all icon

To append or insert a request document image

1. To append another document to the already saved image click on the Modify button.
2. Keeping the Append box ticked insert the document to be scanned into the scanner and click the Scan button
3. Click on the Scan button once more
4. Click on the Close button
5. Click on the OK button if the scanned image is clearly visible and is the correct one.
6. If the image is not of good quality or incorrect then click on the Cancel button
7. To insert an image, in the Add/Modify Image window click on the Insert box to insert the next image instead of append
8. Click on the Scan button once more
9. Click on the Close button

To delete a page in a request document image

1. To delete a page that has been scanned then there must be more than one page scanned for that document. If there is only one page scanned and this needs to be deleted, the document must be inactivated. click on the Modify button to bring up the Add/Modify Image window
2. Find the page to be cut by clicking on the left or right arrows at the bottom left of the image. Then click on the scissors icon.

3. Find the page to be cut by clicking on the left or right arrows at the bottom left of the image. Then click on the delete icon.

To inactivate a request document image

1. Click on Inactivate the image button.
2. Click on the Yes button.
Scanning Result from Referral Laboratory

To scan a result document image

1. Double click on the Accession Result Entry (ARE) icon
2. Type the accession number and click on retrieve
3. Type “See results in PowerChart” in the result cell
4. Click on the Result Images icon on the toolbar.
5. Click on New button at bottom left.
6. Alternatively click on the Scan/Import icon
7. Click on the down arrow in the *Select an image type field.
8. Select the image type relevant to the result image.
9. If External Result is selected then the result will be automatically be chartable while any other choice is defaulted to non-chartable.
10. Place a document in the scanning tray and click on the Scan button
11. Click on the Scan button once more
12. Click on the Close button

To modify a result document image

1. Click on the Result Images icon on the toolbar
2. Click on the result image icon for the test
3. Click on the Modify button

To view a result document image

1. Click on the Result Images icon on the toolbar
2. Click on the result image icon for the test

To delete a result document image

1. Click on the Result Images icon on the toolbar
2. Click on the result image icon for the test
3. Select the page to be deleted by using the arrow keys left or right until the correct page is visible.
4. Click on the Delete icon
**Importing PDF file in ARE (Amino Acids Quantitation and Amino Acids Quantitation MSUD only)**

1. Double click on the Accession Result Entry (ARE) icon.
2. Type the accession number and click on retrieve.
3. Type “See image” in the Amino Acids graph or CSF Amino Acids graph.
4. Click on the Result Images icon on the toolbar.
5. Click on New button at bottom left.
6. Alternatively click on the Import icon.
7. Click on the down arrow in the *Select an image type field.
8. Checking the box next to Chartable Image.
9. Select the image from:
   - G:\\BIOGEN\\Diagnostic Lab\\AAQuant\\Reporttap\\Plasma\\APR reports\\2013 (For PLAA)
   - G:\\BIOGEN\\Diagnostic Lab\\AAQuant\\Reporttap\\CSF\\APR reports\\2013 (For CSFA)
10. Click Open then OK.
11. Click on the Close button.
Execute a Worklist in Explorer Manual

For BG UMP, BG EXVL and BG OROTG worklists

8. Double-click Explorer Menu button on Appbar
9. Double-click the folder - Main Menu on the right hand side
10. Double-click Pathology Reports
11. Select the appropriate worklist and double-click

12. Click Execute

13. Report Output is generated

14. Copy the patients lists to the appropriate worklist template in G:// Drive
For BG Multitests worklists

7. Double-click Explorer Menu button on Appbar
8. Double-click the folder - Main Menu on the right hand side
9. Double-click Pathology Reports
10. Select BG Multitest Worklist
11. Checking the test that you want
12. Click Execute